Video Article

Examination of Mitotic and Meiotic Fission Yeast Nuclear Dynamics by Fluorescence Live-cell Microscopy

Wilber Escorcia¹,², Kuo-Fang Shen¹, Ji-Ping Yuan¹, Susan L. Forsburg¹

¹Program in Molecular and Computational Biology, University of Southern California
²Leonard Davis School of Gerontology, University of Southern California

Correspondence to: Susan L. Forsburg at forsburg@usc.edu

URL: https://www.jove.com/video/59822
DOI: doi:10.3791/59822

Keywords: Biology, Issue 148, Fission yeast, mitosis, meiosis, DNA replication, chromosome segregation, cell division, live-cell microscopy
Date Published: 6/24/2019


Abstract

Live-cell imaging is a microscopy technique used to examine cell and protein dynamics in living cells. This imaging method is not toxic, generally does not interfere with cell physiology, and requires minimal experimental handling. The low levels of technical interference enable researchers to study cells across multiple cycles of mitosis and to observe meiosis from beginning to end. Using fluorescent tags such as Green Fluorescent Protein (GFP) and Red Fluorescent Protein (RFP), researchers can analyze different factors whose functions are important for processes like transcription, DNA replication, cohesion, and segregation. Coupled with data analysis using Fiji (a free, optimized ImageJ version), live-cell imaging offers various ways of assessing protein movement, localization, stability, and timing, as well as nuclear dynamics and chromosome segregation. However, as is the case with any other microscopy methods, live-cell imaging is limited by the intrinsic properties of light, which put a limit to the resolution power at high magnifications, and is also sensitive to photobleaching or phototoxicity at high wavelength frequencies. However, with some care, investigators can bypass these physical limitations by carefully choosing the right conditions, stains, and fluorescent markers to allow for the appropriate visualization of mitotic and meiotic events.

Video Link

The video component of this article can be found at https://www.jove.com/video/59822/

Introduction

Live-cell microscopy allows researchers to examine nuclear dynamics without killing fission yeast cells and eliminates the need for lethal fixatives and stains. It is possible to observe the stability, movement, localization, and timing of fluorescently tagged proteins that are involved in important events such as chromosome replication, recombination, and segregation, in addition to the membrane and cytoskeletal movements. By maintaining cell viability and non-toxic signal detection, there is minimal physiological intrusion. When performed properly, this microscopy method can reduce confounding effects that arise from the extended technical handling or from spurious chemical reactivity. Furthermore, during an experiment, researchers can make pertinent observations of fission yeast nutritional and stress states, proliferative efficiency, and apoptotic status that indicate inappropriate imaging parameters or abnormal cell physiology¹,²,³.

Mitosis and meiosis are characterized by nuclear and cellular division. In meiosis, contrary to mitosis, genetic content is halved as parent cells give rise to daughter cells⁴. Because live-cell imaging provides a temporal dimension in addition to the spatial relationship, large numbers of cells can be examined in real-time. Live-cell microscopy has enabled researchers to examine the dynamics of nuclear division using fluorescent tags for histones⁵, cohesin subunits⁶, microtubules⁷, centromeres⁸, kinetochores⁹, components of the spindle pole body (SPB)¹⁰, and those of the chromosome passenger complex (CPC)¹¹. Outside of the chromosome segregation apparatus, live-cell imaging has also captured the behavior of proteins necessary, but not directly involved in chromosome segregation. The function of these proteins has been shown to influence replication, chromosome recombination, nuclear movement, and chromosome attachment to microtubules¹²-¹⁴. These observations have contributed to a better understanding of cellular events whose functional components were not amenable to biochemical or genetic examination. With new advances in microscopy technology, limitations such as poor resolution, photobleaching, phototoxicity, and focus stability will lessen, thereby facilitating better real-time observations of mitotic and meiotic nuclear dynamics¹²,¹³,¹⁴. Meiosis is particularly challenging as it is a terminal differentiation pathway that requires close attention to timing.

The goal of this protocol is to present a relatively simple method for examining real-time fission yeast nuclear dynamics in mitosis and meiosis. To accomplish this, it is necessary to use cells that have not been exposed to environmental stress, prepare agarose pads that can withstand prolonged imaging, and mount cells at densities that facilitate visualization of single-cell dynamics. Moreover, this protocol makes use of cells carrying fluorescently tagged proteins that serve as useful markers for nuclear kinetics (Hht1-mRFP or Hht1-GFP), chromosome segregation (Sad1-DsRed), cytoskeleton dynamics (Atb2-mRFP), transcriptional activation in G1/S (Tos4-GFP), and cohesion stability in meiosis (Rec8-GFP). This method also introduces additional nuclear and cytosolic markers (Table I) that can be used in different combinations to address questions about specific cellular processes. Furthermore, basic Fiji tools are featured to help researchers process live-cell images and analyze
different types of data. The strength of this approach stems from the use of real-time observations of protein dynamics, timing, and stability to describe processes that are integral for the proper execution of mitosis and meiosis.

Protocol

1. Media Preparation

1. Stock solutions

1. Prepare a 50x salt stock solution by adding 52.5 g of MgCl₂·6H₂O, 0.735 g of CaCl₂·2H₂O, 50 g of KCl, and 2 g of Na₂SO₄ in a bottle containing 1 L of distilled water. Mix the solution thoroughly and sterilely by filtration. Place at 4 °C for long-term storage.
2. Make a 1,000x vitamin stock solution by mixing 1 g of pantothenic acid, 10 g of nicotinic acid, 10 g of inositol, and 10 mg of biotin in a bottle containing 1 L of distilled water. Mix the solution well and sterilely by filtration. Keep at 4 °C for long-term storage.
3. Prepare a 10,000x mineral stock solution by adding 5 g of boric acid, 4 g of MnSO₄·4H₂O, 2 g of FeCl₃·6H₂O, 1 g of KI, 0.4 g of molybdate, 0.4 g of CuSO₄·5H₂O, and 10 g of citric acid in a bottle containing 1 L of distilled water. Mix the solution thoroughly and sterilely by filtration. Place at 4 °C for long-term storage.
4. Make individual nutrient stock solutions by adding 7.5 g of either adenine, histidine or lysine into a bottle containing 1 L of distilled water. Use only 3.75 g to make the uracil solution. Sterilize solutions by autoclaving.

**NOTE:** Over time, uracil precipitates out of solution. To bring into the solution again, warm in the microwave at 60% power in 10 s increments or place in a 55 °C water bath for 20 min. Swirl the warm solution until all uracil clumps disappear.

2. Yeast extract plus supplements (YES)

1. In a 2 L flask, add 1 L of distilled water, 5 g of yeast extract base, 30 g of glucose, and 225 mg each of adenine, uracil, L-histidine, L-leucine, and L-lysine. Add 20 g of agar to make the solid medium.
2. Use a magnetic stir bar to completely dissolve ingredients into the solution. Agar will melt after the medium is sterilized by autoclaving.

**NOTE:** For convenience, ready-to-use YES powder is also commercially available.

3. Edinburgh minimal medium (EMM) and pombe glutamate medium (PMG)

1. In a 2 L flask, combine 1 L of distilled water with 3 g of potassium hydrogen phthalate, 2.2 g of Na₂HPO₄, 5 g of NH₄Cl, 20 g of glucose, 20 mL of salt stock solution, 1 mL of vitamin stock solution, and 0.1 mL of mineral stock solution. Replace NH₄Cl with 2.2 g of L-glutamic acid monosodium salt to prepare PMG. To make the solid medium, add 20 g of agar.
2. Using a magnetic stir bar, dissolve ingredients thoroughly. Agar will melt after the medium is sterilized by autoclaving. Before use, add nutrient stock solutions as necessary. For every 1 L of medium, add 15 mL each of adenine, leucine, histidine, and lysine. Use 30 mL for uracil, since it is less concentrated than the other nutrient solutions.

**NOTE:** For convenience, ready-to-use EMM and PMG powders are also commercially available.

4. Malt extract (ME)

1. Use a 2 L flask to mix 1 L of distilled water with 30 g of malt extract and 225 mg each of adenine, uracil, histidine, and leucine. Adjust the pH to 5.5. Include 20 g of agar to make the solid medium.
2. Dissolve components into the solution using a magnetic stir bar. Agar will melt after the medium is sterilized by autoclaving.

5. Sporulation agar with supplements (SPAS)

1. In a 2 L flask, add 1 L of distilled water, 10 g of glucose, 1 g of KH₂PO₄, 1 mL of vitamin stock, 45 mg each of adenine, uracil, histidine, leucine, and lysine hydrochloride. Add 20 g of agar to make the solid medium.
2. Use a magnetic stir bar to thoroughly combine ingredients. Agar will melt after the medium is sterilized by autoclaving.

2. Fission Yeast Culture

1. Use YES solid medium to wake up fission yeast strains from cryogenic preservation. Depending on the temperature requirements of each strain, incubate at either 25 °C or 32 °C for 3-5 days.
2. When colonies are visible, prepare a starter liquid culture. Pick cells from individual colonies and inoculate them into test tubes containing 3 mL YES liquid medium. Grow at the appropriate temperature to the mid- or late-log phase.

**NOTE:** For proper aeration, use tubes or flasks with volumes at least 5x greater than the intended liquid culture volume. Shaking speeds between 150-220 rpm are customary for routine culture growth.

3. Dispense 250-500 µL of starter culture into a 50 mL flask containing 9.5-9.75 mL of either YES, EMM or PMG plus appropriate supplements. Allow cells to grow to the desired density and check under the microscope for the proper cell morphology and nutritional state.

**NOTE:** To store awoken strains for up to a month, seal YES plates with paraffin tape and place at 4 °C.

3. Sample Preparation

1. Microscope slide setup

1. Add 2 g agarose in a 500 mL beaker containing 100 mL of either minimal medium plus supplements (mitosis) or liquid SPAS (meiosis). Warm the agarose solution in a microwave oven at 60% power in 10 s increments or place in a 55 °C water bath for 10 min. Swirl the solution to ensure efficient melting. Prepare agarose slide-making setup (Figure 1A) to ensure quick pad preparation and prevent molten agarose from solidifying prematurely.
2. Allow the molten agarose to cool for 1 min at room temperature and dispense 50-100 µL spots on microscope slides using wide-bore pipette tips. Before the agarose cools down, place a microscope slide on the top to generate a spread pad of about 1.5-2 cm in
diameter (Figure 1B-C). The width of the agarose pad is typically proportional to the length of imaging time. In other words, thicker pads withstand longer imaging periods.

3. Use a hydrocarbon mixture as a sealant to ensure proper coverage of slides with thick agarose pads and to prevent cell death from solvent exposure at the coverslip edges. Mix equal parts (w/w) of petroleum jelly, lanolin, and paraffin in a 500 mL beaker. Heat ingredients on a hot plate at 120 °C for 5 min. As components melt, carefully swirl the molten solution to ensure appropriate mixing.

2. Sample setup

1. For the examination of mitotic events, grow cells from starter cultures in either liquid EMM or PMG plus supplements to approximately mid-log phase (OD595 of 0.4). Centrifuge 1 mL of the cell suspension at 1,375 x g for 1 min, remove the supernatant and resuspend the cell pellet in the minimal medium plus supplements to a final volume of 100 µL.

2. To image meiotic events, grow cells from starter cultures in the minimal medium plus supplements to late-log phase (OD595 of 0.7-1.0). Combine equal volumes of opposite mate-type cells (h+ and h−) in a 1 mL cell suspension. Centrifuge cells at 1,375 x g for 1 min and resuspend the pellet in liquid ME. Repeat this step thrice to ensure efficient nutrient removal.

3. After the last ME wash, resuspend cells in 1 mL of ME and add it to a 50 mL flask containing 9 mL ME. Incubate for 12-16 h at 22-25 °C on minimal rotation speed (50-100 RPM). Abundant cell flocculation, which results in many round fission yeast clumps and indicates efficient mating.

4. Take 1 mL sample of the mating culture and centrifuge at 1,375 x g for 1 min. Eliminate the supernatant but leave 250 µL in the tube to resuspend cells. Before placing cells on agarose pads, vortex vigorously for 5 s to disrupt clumps.

NOTE: The remaining 250 µL ME used to resuspend cells contains mating factors that help cells enter meiosis.

5. Place 20 µL of either a mitotic or meiotic cell suspension on a 2% agarose pad. Remove any excess medium by inverting the slide and putting it on the top of a lint-free paper towel for 2-3 s (Figure 1D). Set the slide pad-side up and gently place a glass coverslip, ensuring not to generate air bubbles (Figure 1F).

NOTE: Eliminating excess medium with a paper towel is more time-efficient than gravity absorption, which is particularly critical in meiosis experiments.

6. To create a cell monolayer, rotate the coverslip clockwise with the index finger for one (mitosis) or two (meiosis) full turns (Figure 1F). Ensure that the cell matter disperses across the agarose pad allowing for the better separation of single cells or asci. With the aid of a small wooden stick, dispense molten sealant along the edges of the coverslip to seal each agarose pad (Figure 1G).

7. Once the agarose pad is sealed, place it on the microscope stage and let it equilibrate for 10-15 min at the appropriate imaging conditions (e.g., temperature) (Figure 1H) to allow air bubbles to dissipate and let any last-minute agarose shifts to occur. Begin imaging once the slide is efficiently equilibrated and do not remove it from the stage until data collection ends.

NOTE: Control of temperature and humidity is determined by the microscope system employed and specific experimental requirements. If present, apply the temperature and humidity control to all imaging experiments. If absent, researchers must devise a way to prevent temperature fluctuations, especially during meiosis experiments.

4. Live-cell Imaging² and Processing

1. Use the 40x objective to find appropriate fields of view to the image. Switch to the 60x objective to begin data acquisition. Depending on the microscope system used, subsequent refocusing and sectioning on the sample at each time point will occur manually or through a microscope- or software-automated process.

NOTE: The images presented in this protocol were collected using a deconvolution, fluorescence microscope equipped with Sedat, RFP and GFP filter sets, nano-motion stage, 60x NA 1.4 objective lens, and 12-bit CCD camera. Built-in mechanical shutters and motorized filter wheels allowed for the reduced excitation exposure and photobleaching of samples.

2. Use appropriate software to acquire and process images. To deconvolve images, employ manufacturer-provided optical transfer functions.

NOTE: For details on the microscope equipment and software used in this protocol, refer to the Table of Materials.

3. To use a conventional fluorescence microscope to acquire live-cell images ensure that the microscope collects data digitally, has 40x or 60x objectives with numerical apertures (NA) greater than 1.2, and is able to perform optical sectioning.

NOTE: Without these requirements, images will show reduced resolution, compromising the quality of microscopic measurements and qualitative observations.

4. Use free plug-in programs (e.g., Fiji) to minimize systematic blur errors arising from the contrast loss during the image acquisition and to ensure proper quantitative analysis of the fluorescence intensity and of other temporal and dynamic events within the cell.

NOTE: Other available commercial deconvolution programs can be found in the Table of Materials.

5. Choose the microscope filter sets that best match the fluorophores under observation. Ensure that the excitation and emission filters have the right band passes that allow for the specific detection of fluorescent proteins. For example, to detect CFP signal, an excitation and emission band pass of 430/25 and 470/30 is appropriate, but not for RFP fluorescence.

6. Use a minimal-effective-settings approach (MESA) when imaging fission yeast at multiple time points. In other words, avoid prolonged use of excitation wavelengths and employ the lowest excitation power and exposure time that generate acceptable, yet quantifiable and reproducible imaging data.

7. For prolonged imaging during mitosis or meiosis, limit the interval between acquisition time points to 5-10 min. Although 2% agarose pads can withstand 12 to 16 h imaging sessions, cell-shifting due to agarose evaporation is likely. Therefore, perform full mitosis or meiosis experiments in 4-6 h or 8-10 h windows, respectively.

8. Collect imaging data for 4-8 h consisting of at least 24-48 acquisition time points, respectively, one fluorescence protein, and a z-stack per time point and fluorescent channel comprised of 13 sections with 0.5-µm spacing using a 60x objective. This requires at least 0.5-1 GB of hard drive storage space. Thus, besides eliminating photobleaching and cell-shifting, create a workflow that considers computing capabilities.

NOTE: These acquisition parameters are typically set and modified in the software that controls microscope functions and which collects and processes images.
9. To examine specific nuclear processes in closer detail, perform image acquisition every 5-10 s, as long as the emission does not decrease substantially after frequent exposure. Carry out a preliminary fluorescence intensity analysis over different time periods to determine the point after which the accuracy of the collected data is no longer reliable.1, 4
10. In the image-acquisition and image-processing software, use maximum intensity projection on the image z-stacks to observe all structures with high fluorescence density on a 2D plane regardless of their vertical location.1, 2, 3. This facilitates a rapid examination of nuclear processes occurring in different voxels. Collect a mid-focal bright-field image to generate a reference picture of the cells under observation.

5. Image Analysis

NOTE: Image analysis in this protocol is performed using Fiji. For other analysis programs and Fiji plug-ins see Table of Materials.

1. Upload a deconvolved image by selecting the Bio-Formats Importer feature under the Plugins menu. In the Import Options pop-up window, select Hyperstack, Default color mode, and check Autoscale before pressing the OK button.
2. Ensure the displayed window has the correct number of fluorescence channels and time frames by scrolling sideways on the respective bars at the bottom. Save as a Tiff file, which does not compress data and prevents information loss.
3. Open an image that contains a scale bar generated during data processing by the microscope software. Determine the pixel length of the scale bar using the Straight Line tool to draw a parallel line of similar size and select Measure from the Analyze menu. Add a scale bar by setting the image pixel-to-µm ratio by selecting Set Scale from the Analyze menu.
   1. In the Set Scale pop-up window, enter the calculated Distance in pixels and Known distance in µm, set Pixel aspect ratio to 1.0, put micron as the Unit of length, and check the Global box before clicking the OK button.
4. Use the Set Measurements option under the Analyze menu to choose different parameters to quantify when selecting Measure. For the purposes of this protocol, select the following metrics: Area, Perimeter, Mean gray value, Median, Min & max gray value, Integrated density, Stack position, and Display label.
5. Depending on the precision of the collected data, enter more than 1 for the Decimal places option and check the Scientific notation box if necessary. After applying the Measure command, a Results pop-up window will show the values for each pertinent parameter. Save the results as a .csv file for future analysis in a statistics program.
   NOTE: It is not necessary to separate an image into its constituent fluorescent channels for determining the length, unless there is signal interference among the different colors in which case follow the step detailed below.
6. In the case of signal interference, select Color and Channels Tool from the Image menu and analyze each color separately. To measure the length of non-linear structures, right-click on the Line Tool and use the Segmented Line or Freehand Line option to trace the desired objects.
   1. For linear structures or to determine the distance between two points, use the Straight Line feature and select Measure from the Analyze menu. Values for length in µm will be automatically added to the parameters previously selected under the Set Measurements option.
7. For measuring changes in the signal size and fluorescence intensity, first create a region of interest (ROI) library, which increases quantification accuracy and facilitates speedy measurements across an image stack. Select Color and Channels Tool under the Image menu.
8. In the Channels pop-up window, check the color channel for which intensity or area will be measured. Choose the Adjust and Threshold features under the Image menu. Check the Dark background box, select the Default method (unless otherwise required by the collected data), and pick Red to overlay the signals of interest.
   NOTE: Measurement of protein stability, movement, and localization are closely dependent on the color threshold used for creating ROI libraries. It is important to choose the correct thresholding method for the type of fluorescent marker signal to be visualized.17, 18
9. Use the Wand tool to highlight each structure of interest and press the letter T on the keyboard to add the selected ROI to the pop-up ROI manager window. Repeat this process for each slice (time frame) in the image stack and store all ROIs by clicking on the More button and selecting Save.
10. Open the zipped ROI folder to load the ROI manager and click on each ROI identifier on the left side panel. Select Measure from the Analyze menu and repeat this command on each ROI identifier to quantify the objects of interest in all slices of the image stack.
11. If cell shifting is not an issue and the focal plane remains the same for all slices of the stack, click on Multi measure in the ROI manager. In the pop-up window, select Measure all slices instead of One row per slice to iterate measurements across the image stack. Save results as a csv file and analyze measurements in a statistics program.
12. For multiple nuclear signals comprising the structure of interest, press the Shift key while selecting objects with the Wand tool to create a single ROI. Alternatively, create an ROI of constant size with the Oval tool to encompass all the signals of interest.
   NOTE: This oval approach may be necessary to measure and describe the signal behavior over an area where fluorescence signal changes in size and intensity over time. Signal intensity, in this case, is the mean signal density over a given area.
13. Qualitatively determine co-localization of two fluorescent signals by the change in color of the signal overlap region. However, as the co-localization zone narrows, it is more difficult to distinguish signal overlap. In this case, follow the steps detailed below.
14. Using the Channels Tool, as described in step 5.6, draw a straight line over each signal in question, and select the Plot Profile command under the Analyze menu.
   1. Repeat this step for all colors in question using the same drawn line.
   2. In the Plot of sample pop-up window that appears after each profiling step, press the List button to call up a Plot Values window, and save the measurements for each signal as a csv file.
   3. In a statistics program, create a graph that plots the Gray Value for each signal against its corresponding location (in µm) along the drawn line. Lack of overlap among signal profile plots generally indicates the lack of co-localization.
   NOTE: Use the Plot Profile tool on projected images to examine signal co-localization. This is only reliable if such overlap is also observed through the image z-stack.
15. To monitor the dynamic behavior of fluorescent proteins over time use the Multi Kymograph tool found under the Analyze menu. The resulting image shows the fluorescent signal movement through a series of condensed snapshots in each slice of the z-stack, which represents individual time points.

   1. Use the Channels Tool as described in step 5.6 to isolate the object of interest in the correct channel. Make sure the selected object or structure does not shift considerably through the z-stack. Place a straight line or rectangle over the object, select the Multi Kymograph tool from the Analyze menu, and enter the desired width of the line overlaying the object.

16. Create image panels that show nuclear dynamics over a specific time window using the Channels Tool as described in step 5.6 and by selecting the Stacks and Make Montage tools from the Image menu. In the Make Montage pop-up window, enter the number of Columns and Rows desired, set a Scale Factor of 1.0, choose the First and Last slices (time frames), and change Border width to at least 5 before pressing OK. It is possible to choose which images in the stack to show by changing Increments to suit the desired sequence.

   1. To generate a movie, upload the desired hyperstack, select Save as an avi file from the File menu, choose none for Compression, and enter a Frame rate of 2-8 fps. Select the Make Montage command while picking Composite in the Channels Tool to merge or separate all colors comprising the image.

   NOTE: Two avi files (Movie 1-2) are provided in this protocol. Use them in Fiji to try different features highlighted throughout step 5.

   2. To show a single, representative cell, use Transform and Rotate from the Image menu and enter degrees of rotation. Negative numbers rotate objects to the left, while positive values rotate objects to the right. Once the cell is in the proper orientation, draw a rectangle that encompasses the entire cell through the z-stack or during the time frames of interest and select Crop from the Image menu. Proceed as mentioned in step 5.16 and 5.16.1 to generate an image panel or movie.

17. Add a scale bar to the image panel or movie by selecting Tools and Scale bar from the Analyze menu. In the Scale Bar pop-up window, enter 5-15 for Width in microns for single cells or 100-250 for entire fields of view, choose white or black for Color, and pick an appropriate Location to place the scale bar.

   1. For movies, it is useful to show time progression during nuclear events. To show time change between frames, select Image, click on Stacks, use the Time Stamper tool, indicate the start frame in the time series, and select an appropriate location for the time display.

**Representative Results**

Whether live-cell imaging is used for mitosis or meiosis, it is crucial to employ healthy fission yeast cells before making any type of observation. The quality of the resulting data relies heavily on the starting material. If cells starve due to nutrient limitation or overgrowth, they will show excess vacuoles and decreased cell size (Starvation, Figure 2A). For mitosis experiments, it is best to avoid using cells that show cellular stress (Starvation, Figure 2A). Otherwise, experimental results will be inconsistent and irreproducible. To circumvent this limitation, choose proper wild type controls and become familiar with the various phenotypes of mutants of interest. For example, mitotic cells starved for 12 h cease to actively replicate DNA. Since Tos4-GFP expression is associated with G1/S-phase activity, logarithmic cells carrying this marker and one for nuclear division (Sad1-DisRed) show pan-nuclear Tos4-GFP expression, Sad1-DisRed foci separation, and ongoing septation (suggesting active DNA replication and cell division) (Log, Figure 2A), while starved cells show no such activity (Starvation, Figure 2A). This result is consistent with the effects of nutrient limitation in fission yeast, which decreases transcription in G1, activates the G1/S cell cycle checkpoint, and promotes G0 entry. For meiosis experiments, cells must grow to a high density, but without reaching the stationary phase. Afterward, cells of both mate types are mixed and incubated together in low nitrogen media. Failure to mate, as is the case when cells are not sufficiently starved of nitrogen, will prevent them from entering meiosis (Inefficient, Figure 2B). Robust flocculation of the mating cell suspension increases cell-to-cell interaction and thus indicates successful mating and efficient meiotic induction (Efficient, Figure 2B).

Agarose gel pads and physical disruption of cell clumps guarantee proper visualization of single cells or asci (Log, Figure 2A; Efficient, Figure 2B). Pads must provide a rigid, yet moist platform on which cells are simultaneously fixed in place and protected from desiccation. In addition, pads must be thick enough to withstand changes due to evaporation and provide a levelled surface that permits proper focus throughout image acquisition (Figure 1C). Coverslip rotation is necessary to separate and spread cells within mating aggregates (Figure 1F). Efficient, Figure 2B). Without this step, few asci but numerous haploid cells are observed because asci become trapped within inaccessible layers of mating clumps, while haploid cells are free to populate all available monolayer spots (Figure 2B). Even for mitotic experiments, where cell clumping is less problematic, coverslip rotation moves cells around the pad to create a single cell layer with sufficient space between cells to reduce crowding effects and allow for cell duplication (Log, Figure 2A).

Atb2 is an α-tubulin component involved in chromosome segregation in fission yeast mitosis and meiosis. When fluorescently tagged, this cytoskeleton component allows for examination of the stages that characterize nuclear separation in mitosis. During prophase (0'-20', Figure 3A), nucleation of the mitotic spindle occurs in the nuclear side of the spindle pole bodies (SPBs), as revealed by Atb2-mRFP fibers set against an Htt1-GFP pan-nuclear background. During the metaphase-anaphase transition (20'-40', Figure 3A) the mitotic spindle extends outward and the nucleus splits in two. As the cell enters telophase (60'-80', Figure 3A), Atb2-mRFP expands bidirectionally until chromosomes are entirely separated. After this point, Atb2-mRFP fibers regroup and spread across the cell surface to regain their interphase form in each of the resulting daughter cells. Cytokinesis (>120'), Figure 3A) occurs only after a septum forms and divides the cell by fission. Following changes in Htt1-GFP intensity over a mitotic cycle reveals three important steps in nuclear dynamics: metaphase-anaphase (medium intensity, DNA compaction: 20'-40', Figure 3A-B), telophase (low intensity, DNA separation: 60'-80', Figure 3A-B), and G1 (increasing intensity, DNA duplication: 100'-120', Figure 3A-B). Similarly, but using cells that only carry Htt1-mRFP and employing the multi-kymograph tool (see step 5.15) in Fiji, it is possible to observe mitotic division from metaphase to telophase and evaluate the nuclear movements involved during proper sister chromatid segregation (Normal, Figure 3C). Mis-segregation kymographs show signal activity between the two main nuclear paths, indicating possible mis-segregation due to chromosome fragmentation or inappropriate chromatid separation (Lagging, Figure 3C).
As mentioned previously, in budding and fission yeast, Tos4 is transcribed in G1 and functions during DNA replication in S phase22,23. This can be observed in a kymograph where Tos4-GFP expression increases in the nucleus after Sad1-DsRed10 foci move to opposite directions (indicating nuclear division), but before the septum forms, which precedes cytokinesis (30', Figure 3D; 36', Figure 3E). The phase of high Tos4-GFP activity begins at the end of the M1/G1 transition (45', Figure 3E) and ends in G2 (>60', Figure 3E), right after the cell division. While greatly diffused during G1, Tos4-GFP signal intensity increases post anaphase and throughout S-phase and co-localizes with segregated Sad1-DsRed foci (45'-60', Figure 3E). This result reveals the septation period in fission yeast when genome duplication has begun in daughter cells (G1/S), but cytokinesis has not occurred yet.

Hht1 is histone H3 in fission yeast and is commonly modified with fluorescent tags to visualize nuclear DNA5,14. In mitosis, as cells transition from metaphase to telophase (20'-120', Figure 3A), two distinguishable changes to nuclear mass are observed. The first change involves a contraction of nuclear size in metaphase (20', Figure 3A), while the second shows nucleus splitting during anaphase (40', Figure 3A). Besides sharing these changes with mitotic cells, meiotic cells exhibit nuclear oscillation (i.e., horse-tailing) (-100' to -50', Figure 4A-B) during homologous recombination and further reduction of nucleus size at the end of anaphase II (70'-90', Figure 4A). Hht1-mRFP is used to examine mis-segregation phenotypes such as lagging or fragmented chromosomes (Lagging, Figure 3C). It is also employed to observe and describe the nuclear dynamics in each of the phases of meiosis (Figure 4A-B). Nuclear mass is large and fluctuates in size during much of horse-tailing (HT: -100' to -50', Figure 4A-B)). As cells enter metaphase (MT: -40' to 0', Figure 4A-B), nuclear size and oscillation decrease, consistent with increased condensation activity at this stage. The onset of both anaphase I (Mi: 10'-60', Figure 4A-B) and II (MII: 70'-90', Figure 4A-B) is associated with further nuclear reduction and lack of nuclear movement, which correlates well with the two nuclear divisions that characterize meiosis I and II (MI & MII). Thus, meiosis is associated with nuclear size fluctuations when homologous chromosomes align and recombine and with nuclear size reductions following two rounds of chromosome separation. Alleles that change these nuclear dynamics are likely associated with genome stability regulation in meiosis5,12,13.

Rec8 is the α-kleisin subunit of meiotic cohesin in fission yeast. It is loaded onto the chromatin after DNA replication (mei-S) and keeps sister chromatids tethered to each other until anaphase II. After metaphase I, Rec8 is removed from chromosome arms by separase and is protected at the centromere by Sgo1-PP2A. At the end of homolog segregation, Rec8 is also eliminated at the centromere, thereby allowing for sister chromatid separation (Figure 5A)5,24. Rec8-GFP along with markers of chromosome segregation such as Sad1-DsRed or Hht1-mRFP allow for the visualization of cohesin dynamics during meiosis. Rec8-GFP signal is pan-nuclear during mei-S (-90% to -50', Figure 5A-B), and metaphase I (-40' to 0', Figure 5A-B). This observation reveals the association of Rec8-GFP along chromosomes axes that follows DNA duplication. As cells enter anaphase I (10', Figure 5A-B), Rec8-GFP intensity decreases throughout the nucleus but remains strong at the centromere, where it forms a focus in each nuclear mass (20'-70', Figure 5A-B). This result is consistent with Rec8-GFP degradation along chromosome arms but not at the centromere, that ensues after homolog segregation. Before anaphase II, the Rec8 focus disappears, freeing sister chromatids for separation in MII (70'-80', Figure 5A-B). The Rec8-GFP marker is, thus, useful to examine conditions that disrupt the establishment, removal, and overall stability of meiotic cohesion. Paired with a marker of nuclear division such as Hht1-mRFP5,13, Rec8-GFP can be employed to address questions of how cohesion timing and stability prior to and during meiosis affect proper chromosome segregation12,13. This protocol does not address proteins whose dynamics occur primarily in the cytosol. However, Table I shows a few cytosolic proteins that are commonly used to examine cytoskeleton and membrane processes necessary for endocytosis, exocytosis, and cytokinesis among other processes.

Figure 1: Preparation of agarose pads for live-cell imaging. (A) Slide preparation set-up assembled using a pipette tip holder, lab tape, and microscope slides. Placing slides perpendicular to each other creates a pocket where the agarose pad forms. Addition of lab tape pieces at the sides adjusts the agarose pad width to the required specifications. (B) Molten agarose is let to cool down before setting it on microscope slides to make pads. In this step, it is necessary to dispense the agarose volume slowly to avoid creating air bubbles. (C) The top slide is placed on the dispensed agarose spot to form a circular pad with a straight surface, even edges, and no visible agarose cracks. (D) After putting a sample of cell suspension on the agarose pad, invert slide and place atop a lint-free paper towel to remove extra liquid medium. (E) Carefully place a coverslip on the agarose pad, making sure not to trap any air bubbles and checking that the focus plane is flat to avoid cell shifting and focusing issues. (F) Slowly and cautiously, rotate coverslip clockwise to disrupt cell clumps and to generate a cell monolayer that allows for cell expansion and better cell visualization. (G) Use a heated hydrocarbon mixture to seal agarose pads and allow them to equilibrate to the desired temperature before imaging. Please click here to view a larger version of this figure.
Figure 2: Picking the right cells. (A) Top panels show fission yeast cells left to starve in EMM plus supplements for 72 h and bottom panel shows cells undergoing logarithmic growth. In cells that are left to starve, small cell morphologies can be appreciated. The red open arrow shows vacuolar granules that are characteristic of starvation. In logarithmic cultures, cells showing elongated morphologies and septa (red arrow) abound, indicating active cycling dynamics. The right-side panels show cells expressing Tos4-GFP and Sad1-DsRed signals during starvation and proliferation. Pan-nuclear Tos4-GFP expression and Sad1-DsRed signals that localize to opposite cell poles are seen during active proliferation, but not in starvation. (B) Top panel shows cells of the same mate-type (h+) failing to mate efficiently. The red open arrow shows a pair of vacuolar cells undergoing karyogamy. This is not unusual in cultures of h+ cells, where 10% of cells can switch mate-type to h-. Bottom panel shows asci resulting from efficient mating. Zygotic asci take multiple forms including the zig-zag (red arrow) and banana cell shapes (red open arrow). Scale bar = 5 µm in length. Please click here to view a larger version of this figure.

Figure 3: Mitotic nuclear dynamics. (A) Histone H3 (Hht1-GFP) and microtubule (Atb2-mRFP) proteins were followed during one mitosis cycle (120 min). Individual signals for Hht1-GFP and Atb2-mRFP are shown in black and white panels, while the BF merge shows them in their respective colors. (B) Quantification of Hht1-mGFP intensity over a mitotic cycle. The change in Hht1 levels is indicative of nuclear division during mitosis and DNA duplication in G1. (C) Kymographs showing normal or abnormal segregation in mitosis where the resulting nuclear paths either bifurcate and retain DNA integrity or deviate and promote chromosome fragmentation or premature chromatid separation, respectively. (D-E) Kymograph and micrograph panels showing the duration of M-to-G1/S revealed by the segregation of Sad1-DsRed and appearance of nuclear Tos4-GFP signals. Note the middle panels in E which were generated using the FIRE LUT in Fiji to create an intensity-graduated thermal map that facilitates the identification of spots with high Tos4-GFP expression; in this case, localized to the nucleus and overlapping Sad1-DsRed signals, as expected. Scale bar = 5 µm in length. Please click here to view a larger version of this figure.
Figure 4: Meiotic nuclear dynamics. (A) Panel series showing movement, compaction, and division of the nucleus (Hht1-mRFP) during meiosis. Horse-tailing (HT) shows extensive side-to-side nuclear oscillations followed by Metaphase (MT), where nuclear lateral movement decreases and entirely halts right before anaphase I. In meiosis I (MI), the main nuclear mass splits into two, while in meiosis II (MII) four nuclei are generated during the process of sister chromatid separation. (B) Quantification of nuclear area change (Hht1-mRFP) in prophase, metaphase, MI & MII. Nuclear area is dynamic during HT oscillations, becomes condensed in MT, and further decreases in size during MI & MII, where little nuclear movement is observed (Long Nuclear Axis). Measuring the longest nuclear axis (Long Nuclear Axis) is based on the idea that as a circle stretches, it ceases to have a constant diameter and generates at least two main axes: long and short. Thus, when monitoring changes in the nucleus, changes in either the long or short axis provide indications of nuclear movement. Scale bar = 5 µm in length. Please click here to view a larger version of this figure.

Figure 5: Meiotic cohesin dynamics. (A) Panel series showing how Rec8-GFP signal change correlates with meiotic nuclear dynamics. During HT and MT, Rec8-GFP signal is pan-nuclear and follows nuclear movement (Hht1-mFRP). In MI, Rec8-GFP dissipates from the nucleus, leaving only a pair of foci, which is consistent with Rec8 removal from chromosome arms and establishment of Sgo1-PP2A protection at the centromere. As the cell approaches MII, Rec8-GFP foci begin to disappear and are no longer seen right before anaphase II. (B) Quantification of Rec8-GFP intensity from HT to MII. Similar to what is seen in A, GFP signal is high through HT and MT, substantially decreases during MI and completely disappear in MII. This pattern corroborates cohesin dynamics at chromosome arms and the centromere, where it keeps sister chromatids tethered until ready to be separated in MII. Scale bar = 5 µm in length. Please click here to view a larger version of this figure.
<table>
<thead>
<tr>
<th>Protein</th>
<th>Function</th>
<th>Comments</th>
<th>Tag</th>
<th>References</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hht1</td>
<td>Histone H3 involved in DNA packaging</td>
<td>Used to examine chromosome dynamics</td>
<td>Hht1-mRFP</td>
<td>5,14</td>
</tr>
<tr>
<td>Tos4</td>
<td>Tos4 function occurs during G1 phase</td>
<td>Employed to study G1 timing</td>
<td>Tos4-GFP</td>
<td>22,23</td>
</tr>
<tr>
<td>Rad21/Rec8</td>
<td>Cohesin subunits involved in keeping sister chromatids together following replication</td>
<td>Used to analyze cohesion stability during mitotic (Rad21) and meiotic segregation (Rec8)</td>
<td>Rad21-GFP/Rec8-GFP</td>
<td>6,24</td>
</tr>
<tr>
<td>Rad11</td>
<td>RPA activity occurs during mitotic DNA repair, meiotic recombination, and ends in metaphase</td>
<td>Employed to study DNA repair in mitosis and recombination dynamics in meiosis</td>
<td>Rad11-YFP</td>
<td>5,13</td>
</tr>
<tr>
<td>Rad52</td>
<td>Rad52 activity takes place during mitotic DNA repair and meiotic recombination</td>
<td>Employed to study DNA repair in mitosis and recombination dynamics in meiosis</td>
<td>Rad52-CFP</td>
<td>5,13</td>
</tr>
<tr>
<td>Cnp1</td>
<td>Histone H3 CENP-A localizes specifically at the centromere</td>
<td>Used to follow chromosome segregation dynamics in mitosis and meiosis</td>
<td>Cnp1-mCherry</td>
<td>13</td>
</tr>
<tr>
<td>Swi6</td>
<td>HP1 homologue protein involved in heterochromatin formation</td>
<td>Employed to study heterochromatin mobilization at the centromere and telomeres</td>
<td>Swi6-GFP</td>
<td>13</td>
</tr>
<tr>
<td>Sad1</td>
<td>Sad1 is involved in localizing the spindle pole body to the nuclear envelope</td>
<td>Employed to analyze chromosome segregation in mitosis and meiosis</td>
<td>Sad1-mCherry</td>
<td>10</td>
</tr>
</tbody>
</table>

**CYTOSOL & MEMBRANE**

<table>
<thead>
<tr>
<th>Protein</th>
<th>Function</th>
<th>Comments</th>
<th>Tag</th>
<th>References</th>
</tr>
</thead>
<tbody>
<tr>
<td>Atb2</td>
<td>Tubulin alpha 2 involved in microtubule cytoskeleton organization</td>
<td>Used to examine chromosome segregation in mitosis and meiosis</td>
<td>Atb2-mRFP</td>
<td>7,14</td>
</tr>
<tr>
<td>Ync13</td>
<td>Exocytosis and endocytosis regulator involved in vesicle-mediated transport</td>
<td>Employed to study cell-wall integrity during cytokinesis</td>
<td>Ync13-mECitrine</td>
<td>25</td>
</tr>
<tr>
<td>Rlc1</td>
<td>Myosin II subunit involved in contractile ring contraction</td>
<td>Used to explore the dynamics of septum maturation and contraction</td>
<td>Rlc1-mCherry</td>
<td>25</td>
</tr>
<tr>
<td>Ccr1</td>
<td>NADPH-cytochrome p450 reductase that is part of the ER, plasma, and mitochondrial outer membrane</td>
<td>Employed to examine membrane-associated dynamics such as endocytosis, exocytosis, and cytokinesis</td>
<td>Ccr1N-GFP</td>
<td>5</td>
</tr>
<tr>
<td>Gef1</td>
<td>Rho guanyl-nucleotide exchange factor involved in the establishment and maintenance of cell polarity</td>
<td>Used to examine global, microtubule-dependent cell polarity dynamics</td>
<td>Gef1-mCherry-GFP</td>
<td>26</td>
</tr>
<tr>
<td>Fus1</td>
<td>Formin involved in actin fusion focus assembly during cytogamy</td>
<td>Used to study fusion dynamics associated with fission yeast mating</td>
<td>Fus1-sfGFP</td>
<td>27</td>
</tr>
<tr>
<td>Mnn9</td>
<td>Mannosyltransferase subunit involved in protein N-linked glycosylation in the Golgi apparatus</td>
<td>Employed to study cargo maturation in the Golgi as it progresses from cis-Golgi to trans-Golgi</td>
<td>Mnn9-mCherry</td>
<td>28</td>
</tr>
<tr>
<td>Num1</td>
<td>Cortical anchoring factor for dynein involved in horse-tailing</td>
<td>Used to examine mitochondria-dependent dynein anchoring during nuclear oscillation in meiotic prophase I</td>
<td>Num1-yEGFP</td>
<td>29</td>
</tr>
</tbody>
</table>

*Table 1: Markers of nuclear and cytosolic dynamics.*
Movie 1: M-to-G1/S transition showing spindle pole body (SPB; Sad1-DsRed) separation preceding septation and accumulation of Tos4-GFP nuclear signal. Please click here to view this video. (Right-click to download.)
Live-cell imaging during mitosis and meiosis offers the opportunity to examine nuclear dynamics without substantially disrupting fission yeast physiology during data acquisition. However, caution must be exercised to ensure cells grow to the desired densities free of environmental stresses; and for meiosis, that the cells are imaged during the time of terminal differentiation and not too early or late. Excess cellular crowding, starvation, and inappropriate growth temperatures are common factors that contribute to irreproducible observations. In addition, during strain construction, it is crucial to test that fluorescent tags do not interfere with the functions of target genes nor impact overall cell fitness. Failure to closely inspect the phenotypes of strains carrying fluorescent markers may result in inconsistent and incomparable results across similar genotypes.

Though microscope agarose pads are simple to assemble, they can also pose a hurdle in obtaining valuable imaging data. Creating agarose pads is as simple as placing three microscope slides parallel to each other, dispensing molten agarose on the middle slide, and putting a slide that transverses the top of the other slides. It is useful, however, to assemble a slide-maker apparatus that allows for width modifications to manufacture resistant, situation-specific agarose pads. A simple slide-maker that gives pad width flexibility consists of a platform (pipette tips holder or the bench), two microscope slides, and lab tape acting as the pad-width adjusting mechanism (Figure 1A). Exact pad thickness will depend on imaging time requirements, agarose brand, temperature, coverslip sealant, evaporation rate, etc. Thus, it is important to calibrate the imaging system before data acquisition to increase technical reproducibility and to enhance the quality of live-cell imaging. Pad surface, rigidity, and composition are essential during prolonged image acquisition. Agarose has low background fluorescence, can be easily molded, and at the appropriate concentration, withstands structural deformation due to evaporation. Moreover, combining fission yeast media with agarose does not compromise image quality and allows for extended observation of multiple mitoses and meiosis cycles. Also, it is important to avoid any air bubbles for time-lapse microscopy. Inside agarose pads and within the sample, air pockets expand over time, causing cell-shifting and disrupting focal planes. Provided cells are efficiently spread apart by coverslip rotation, researchers can follow mitotic processes across several generations and meiotic events from nuclear fusion to sporulation. Making and choosing the right pad for imaging experiments takes time to master, but once achieved, can contribute to highly informative microscope observations.

As is the case with other methods, live-cell microscopy is not free of technical limitations. The use of fluorescently-tagged proteins introduces boundaries to experiments that limit the scope of what can be studied. Photo-bleaching and photo-toxicity are problems typical of prolonged image acquisition. They can be counteracted by not exposing cells to short wavelengths for too long or too frequently. For experiments involving GFP, CFP, YFP, mRFP, and DsRed, typical fluorescent proteins used in fission yeast live-cell imaging, it is common to employ 5-15% excitation light and 100-500 ms exposure time for routine experiments. These parameters change, however, according to the specific experiment requirements of the researcher. In addition, z-stacks comprised of 9-13 sections with 0.5 µm spacing using a 60x objective is enough to resolve...
the thickness of a fission yeast cell. Moreover, it is important to confirm that fluorescent markers do not disrupt proper regulation or function of target proteins or generate spurious phenotypes. Thus, it is advisable to construct strains containing different fluorescent and affinity tags for the same target gene to corroborate observations by different means. Furthermore, it is the responsibility of researchers to ensure that experimental parameters can be reproduced across experiments and that the collected data is fit for downstream analysis.1,3 No technology can replace the time-tested practice of meticulously validating experimental systems by careful observation and rigorous examination of linearity in detecting fluorescent signals.

Finally, it is crucial to analyze microscopy data in formats that do not modify raw images. Fiji provides excellent documentation tools to keep track of raw data measurements and allows researchers to examine different cell parameters in a single session. These features, as well as its wealth of online tutorials and extensive literature coverage, make Fiji an important tool for measuring, analyzing, and presenting live cell imaging data that describe the nuclear dynamics of fission yeast in mitosis and meiosis.

Disclosures

The authors have nothing to disclose.

Acknowledgments

The authors would like to thank Natalia La Fourcade and Mon LaFerte for making the preparation of this manuscript a more enjoyable endeavor. Thanks to members of the Forsburg Lab who contributed to the completion of this work with their insight, experiment ideas, and moral support. This project was supported by NIGMS R35 GM118109 to SLF.

References